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3 What is Sola-Term 2000 
Sola-Term 2000 is a file management system for the Sola-Scope 2000, a means of 
easily graphing data collected with a Sola-Scope 2000 and the control centre of the 
Solatell Network. 
Sola-Term 2000 allows easy file management including uploading, downloading, 
deleting and renaming of files stored in a Sola-Scope 2000. It allows simple graphing 
of data in Microsoft Excel with only one button click. 
Sola-Term 2000 also manages the Solatell network controlling the scanning policy 
and displaying information about the current state of the sensors. 
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4 Key to notations in this manual. 
 
Keywords – Terminology that relates to icons, buttons or windows within Sola-Term 
2000. All icons are defined in Section 4, each window is defined in it’s own section 
and button within windows will be defined either in the current section or in the 
window definition section. 
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5 Icons 

5.1 Standard icons (Level 1) 

5.1.1  Folder 
Sola-Scope 2000 Window – Represents a bank on the Sola-Scope 2000. 
Local Machine Window – Represents a folder in the same way that Explorer does. 

5.1.2  Open Folder 
Sola-Scope 2000 Window – Represents the current bank. The files from the current 
bank are displayed in the right panel in the window. 
Local Machine Window – Represents the current folder. The files from the current 
folder are displayed in the right panel in the window. 

5.1.3  Sola-Tell File 
Sola-Scope 2000 Window – Represents a file stored on the Sola-Scope 2000 within 
the current bank. 
Local Machine Window – Represents a file (with data from one scan only) stored on 
a local disk. 

5.1.4  Sola-Tell Bank File 
Local Machine Window – Represents a file (with data from two or more scans) stored 
on a local disk. 

5.1.5  Sola-Tell Corrupt File 
Local Machine Window – Represents a file stored on a local disk that has corrupt 
data stored in it. This icon can also represent a Sola-Scope 1 file. 

5.1.6  Large Icons View 
All windows except the Graph window – Changes the view to large icons. 

5.1.7  Small Icons View 
All windows except the Graph window – Changes the view to small icons. 

5.1.8  List View 
All windows except the Graph window – Changes to the list view. 

5.1.9  Details View 
All windows except the Graph window – Changes to detail view. 

5.1.10  Open 
Sola-Scope 2000 Window – Downloads the current selected bank/file(s) and displays 
it/them in the graph window. 
Local Machine Window – Opens the current selected file(s) and displays it/them in 
the graph window. 
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5.1.11  Save 
Sola-Scope 2000 Window – Saves the currently selected bank/file(s) to a local disk. 
Graph Window – Saves the data in the graph window to a file on a local disk. 

5.1.12  Delete 
Sola-Scope 2000 Window – Deletes the currently selected bank/file(s). 
Local Machine Window – Deletes the currently selected file(s). 

5.1.13  Copy 
Sola-Scope 2000 Window – Copies the currently selected bank/file(s) to the system 
clipboard. 
Local Machine Window – Copies the currently selected file(s) to the system 
clipboard. 
Graph Window – Copies the data in the Graph window into the system clipboard. 

5.1.14  Paste 
Sola-Scope 2000 Window – Pastes data from the system clipboard into the currently 
selected file. 
Local Machine Window – Saves the data from the system clipboard into a file on a 
local disk. 
Graph Window – Pastes the data from the system clipboard into the Graph window. 

5.1.15  Refresh 
Sola-Scope 2000 Window – Refreshes the file list. 
Local Machine Window – Refreshes the file list. 

5.1.16  Properties 
Graph Window – Opens the Graph Properties Window. 

5.1.17  Local Machine Window 
Opens and closes the Local Machine Window. 

5.1.18  Sola-Scope 2000 Window 
Opens and closes the Sola-Scope 2000 Window. 

5.1.19  Graph Window 
Opens the Graph Window. 

5.1.20  Receive File 
All Windows – Waits for a file to be sent manually from the Sola-Scope 2000. 

5.1.21  Help 
Opens the help file. 

5.2 Excel and Logging Icons (Level 2) 

5.2.1  Logging 
Opens the logging wizard to start logging. 
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5.2.2  Excel – Single Graph 
All Windows – Sends the data from the currently selected bank/file(s) to Excel and 
graphs the data on a single graph. 

5.2.3  Excel Wizard 
All Windows – Opens the Excel Wizard to allow you to choose where to place you 
data within Excel. 

5.2.4  Excel – Separate Graphs 
All Windows – Sends the data from the currently selected bank/file(s) to Excel and 
graphs each set of data on its own graph. 

5.2.5  Scan 
Starts a scan on the Sola-Scope 2000 and downloads the data to the graph window. 
The pure yellow icon starts a standard scan, the icon with a red centre scan starts an 
auto ranging scan. 

5.3 Networking Icons (Level 3) 

5.3.1  Networking View Window 
Opens and closes the networking view window. 

5.3.2  Networking Errors Window 
Opens and closes the Networking Errors Window. 

5.3.3  Set Baseline 
Networking View Window - Sets the baseline on the current selected Sola-Check 
from the last scan data. 

5.3.4 /  Selected Folder 
Networking View Window – Indicates the currently selected Sola-Check/Sola-Sensor 
2000 that will be used for the next operation. 

5.3.5  Network Monitoring 
Starts and stops network monitoring. 

5.3.6  Permanent Coms 
Toggles permanent coms. 

5.3.7  Set FSD 
Networking View Window - Sets the FSD (Full Scale Deflection) of the currently 
selected Sola-Check/Sensor 2000. 
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6 The Main Window 
 

 
 
The Main window holds most of the windows that will appear when you are using 
Sola-Term 2000, the exceptions being, the Graph window, the windows involved 
with logging and scanning, the Excel wizard and the Options windows. 
Toolbar icons that can be used with more that one window will perform the function 
associated with the currently selected window (see previous section). 
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7 Configuring Sola-Term 2000 - The Options Window 
 

 
(To configure Sola-Term 2000 to communicate with a Sola-Hazard please see the 
Using a Sola-Hazard with Sola-Term 2000 chapter later.) 
 
Sola-Term 2000 needs to be configured correctly to communicate with the Sola-Scope 
2000. Although this configuration is vital, it is very simple. This configuration is set 
within the Options window, that can be opened by selecting the Options menu item in 
the Sola-Scope menu. 

7.1 Configuring the Communications port 
The key option to configure is the communications port (or COM port for short) that 
Sola-Term 2000 uses to communicate with the Sola-Scope 2000. From within the 
Options window this can be done in two ways. 

7.1.1 Using the Detect button with Sola-Scope 2000s. 
• If you have not already opened the Options window, open it by selecting 

Options from the Sola-Scope Menu. 
• Ensure that you have selected Sola-Scope 2000/Sola-Scope 1 in the Select 

attached product frame. For information on using a Sola-Hazard with Sola-
Term 2000 see the Using a Sola-Hazard with Sola-Term 2000 chapter later. 

• Click the Detect button, this will scan COM ports 1 to 4 to see if a Sola-Scope 
2000 is plugged into any of them. 

• If this process finds a Sola-Scope 2000 attached to your computer then it will 
inform you that it has found a Sola-Scope 2000, otherwise it will report that no 
Sola-Scope 2000 was found. 

7.1.2 Select the Com port manually 
• If you have not already opened the Options window, open it by selecting 

Options from the Sola-Scope Menu. 
• Ensure that you have selected Sola-Scope 2000/Sola-Scope 1 in the Select 

attached product frame. For information on using a Sola-Hazard with Sola-
Term 2000 see the Using a Sola-Hazard with Sola-Term 2000 chapter later. 

• Click the up and down buttons next to the detect button to change the COM 
port. This will allow you to set the COM port to a number higher than 4. 
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7.2 Other options 
The other option in the options window is “Ask if you want to refresh the Sola-Scope 
2000s file listing when the program is first started”, this allows you to turn on and off 
the “Refresh file listing” message that appears when you first run the program. 
 
Once you have finished click the OK button to confirm the changes, or Cancel to 
discard the changes made. 
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8 The Sola-Scope 2000 Window 
 

 
The Sola-Scope 2000 Window displays a list of the files stored on your Sola-Scope 
2000. It is split into two sections; on the left there is a list of the banks available and 
on the right a list of the files in the current bank you are viewing. The Open Folder 
icon in the bank section indicates the bank that is currently being viewed. 
 

8.1 Refreshing the Bank and File Listings 
This assumes that the Sola-Scope 2000 is plugged into the PC correctly. 

8.1.1 Using the Refresh Icon 
• If the Sola-Scope 2000 Window is not currently active select it by clicking 

anywhere in the Sola-Scope 2000 Window. 
• Click the Refresh Icon on the toolbar or select the Refresh menu item from 

the Sola-Scope Menu and the Bank and File lists will refresh. 

8.1.2 Using the keyboard shortcuts 
• If the Sola-Scope 2000 Window is not currently active select it by clicking 

anywhere in the Sola-Scope 2000 Window. 
• Either press F5 or hold down CTRL and press R. The Bank and File lists will 

refresh. 

8.2 Changing Banks 
• Double click on the bank that you want to change to and Sola-Term 2000 will 

automatically update the File list. 

Bank 
Area 

File 
Area 
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9 The Local Machine Window 
 

 
The Local Machine Window displays the folder structure of your hard disk and the 
files that you have downloaded from your Sola-Scope 2000 to your PC. It is split in a 
similar way to the Sola-Scope 2000 Window with the file area on the right and the 
folder area on the left, the main difference is that the folder area has a drive selection 
drop-down list above it to allow you to change the drive you are viewing. 

9.1 Refreshing the Folder and File Listings 

9.1.1 Using the Refresh Icon 
• If the Local Machine Window is not currently active select it by clicking 

anywhere in the Local Machine Window. 
• Click the Refresh Icon on the toolbar or select the Refresh menu item from 

the Sola-Scope Menu and the Folder and File lists will refresh. 

9.1.2 Using the keyboard shortcuts 
• If the Local Machine Window is not currently active select it by clicking 

anywhere in the Local Machine Window. 
• Either press F5 or hold down CTRL and press R. The Folder and File lists will 

refresh. 

9.2 Changing Folders 
• Double click on the folder that you want to change to and Sola-Term 2000 will 

automatically update the File list. 
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10 The Graph Window 
 

 
 
The Graph window displays the data currently loaded in Sola-Term 2000. Using the 
mouse pointer you are able to trace the graph by moving it from left to right. This will 
display the wavelength corresponding to the current horizontal position of the mouse 
pointer and it’s associated intensity. If you have more than one graph displayed in the 
graph window, you can tell which graph the data refers to by looking at the graph 
name, displayed to the left of the Wavelength and intensity information. 
 

10.1 Graph Properties Window 

 
 
Clicking on the Properties icon in the Graph window opens the Graph Properties 
window. This window displays the information about the graph that has its name 
displayed in the drop down list at the top of the window. It can be used to determine 
when the scan took place, what the temperature was at the time of the scan, etc… 
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11 The Networking View Window 

 
The Networking View Window displays a list of the Sola-Checks/Sola-Sensor 2000s 
on the network and the two files stored on the current Sola-Check/Sola-Sensor 2000. 
The window is split into two sections; on the left there is a list of the Sola-
Checks/Sola-Sensor 2000s available and on the right a list of the files in the current 
Sola-Check/Sola-Sensor 2000 you are viewing. The Open Folder icon in the bank 
section of the window shows the Sola-Check/Sola-Sensor 2000 that is currently being 
viewed. The Selected Folder Icon indicates the Sola-Check/Sola-Sensor 2000 that is 
currently selected. 
 

11.1 Refreshing the Sola-Check/Sola-Sensor 2000 and File Listings 
This assumes that the Sola-Scope 2000 is plugged into the PC correctly and the 
network has been initialised correctly. 

11.1.1 Using the Refresh Icon 
• If the Networking View Window is not currently active, select it by clicking 

anywhere in the Networking view Window. 
• Click the Refresh Icon on the toolbar or select the Refresh menu item from 

the Sola-Scope Menu and the Sola-Check/Sola-Sensor 2000 file lists will 
refresh. 

11.1.2 Using the keyboard shortcuts 
• If the Networking View Window is not currently active select it by clicking 

anywhere in the Networking View Window. 
• Either press F5 or hold down CTRL and press R and the Sola-Check/Sola-

Sensor 2000s file lists will refresh. 

11.2 Changing Sola-Checks/Sola-Sensor 2000s 
• Double click on the Sola-Check/Sola-Sensor 2000 that you want to change to 

and Sola-Term 2000 will automatically update the lists. 
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12 The Networking Errors Window 

 
The Networking Errors Window displays a list of errors that have occurred on the 
network during the current run. 

12.1 Clearing the list of errors 
To clear the list of errors click on the Clear Button at the bottom of the window and 
the list will be cleared. 
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13 Downloading data from the Sola-Scope 2000 to Sola-Term 
2000 

There are several methods for downloading data from the Sola-Scope 2000 into Sola-
Term 2000, most of which are similar to the methods you would find when using the 
software you use every day. 

13.1 Loading the file into the Graph Window 
Opening a file in the Graph Window from the Sola-Scope 2000 can be performed in 
the following ways. 

13.1.1 Using the Open Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you want to open. 
• Click the Open icon and the file will be downloaded and shown in the Graph 

window. 

13.1.2 Double clicking 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Double click on the file you want to open in the Graph window. 

13.1.3 Dragging and dropping 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you want to open. 
• Drag the file you want to open from the Sola-Scope 2000 window and drop it 

on the graph area of the Graph window. 
 

13.2 Saving a file to disk 
Saving a file from the Sola-Scope 2000 can be performed in the following ways. 

13.2.1 Using the Save Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you wish to save. 
• Click the Save icon and a dialog will appear asking you for a file name. After 

clicking Save button in the dialog box, the file(s) will be downloaded and 
saved to disk.  
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13.2.2 Dragging and dropping 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you wish to save. 
• Drag the file(s) you want to save from the Sola-Scope 2000 window and drop 

it on the file area of the Local Machine window. 
• A dialog will appear asking you for a file name. After clicking Save button in 

the dialog box, the file will be downloaded and saved to disk. 

13.3 Sending a file to Excel. 
Sending a file to Excel from the Sola-Scope 2000 can be performed in the following 
ways. 

13.3.1 Using the Excel - Single Graph Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either click the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you wish to send to Excel. 
• Click the Excel – Single Graph Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button, a progress indicator will appear and your data will be 
transferred to Excel. 

13.3.2 Using the Excel - Separate Graph Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you wish to send to Excel. 
• Click the Excel – Separate Graph Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button, a progress indicator will appear and your data will be 
transferred to Excel. 

13.3.3 Using the Excel Wizard Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• Select the file or files you wish to send to Excel. 
• Click the Excel Wizard Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button, the Excel wizard will now start, follow the instructions 
given in the “The Excel Wizard” section later. 
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13.4 Copying a file from the Sola-Scope 2000 to the system clipboard. 

13.4.1 Using the Copy Icon 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh Icon, pressing F5 or CTRL-R. 

• Select the file or files you want to copy to the system clipboard. 
• Click the Copy icon and the file will be downloaded and copied to the system 

clipboard. 

13.4.2 Using the keyboard shortcut 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh Icon, pressing F5 or CTRL-R. 

• Select the file or files you want to copy to the system clipboard. 
• Hold down CTRL and press C and the file will be downloaded and copied to 

the system clipboard. 
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14 Uploading data from Sola-Term 2000 to the Sola-Scope 
2000 

14.1 Uploading data from the Local Machine Window 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• In the Sola-Scope 2000 Window change to the bank you want to upload the 
file into. 

• Find the file you want to upload in the Local Machine Window. 
• Drag the file you want to upload from the Local Machine Window and drop 

it onto the files in the Sola-Scope 2000 Window you want the data to be 
stored in. 

• The data will now be uploaded to the specified file. 

14.2 Uploading data from the Graph Window 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• In the Sola-Scope 2000 Window change to the bank you want to upload the 
file into. 

• Open the Graph Window. 
• Drag the graph from the Graph Window and drop it onto the file in the 

Sola-Scope 2000 Window you want the data to be stored in. 
• The data will now be uploaded to the specified file. 

Note – This will only work if you have data in the Graph Window, if you do not then 
an error message will appear. 

14.3 Uploading data from the System Clipboard 
• If you have not already opened the Sola-Scope 2000 window, click on the 

Sola-Scope 2000 Window icon and refresh the file list by either clicking the 
Refresh icon, pressing F5 or CTRL-R. 

• In the Sola-Scope 2000 Window change to the bank you want to upload the 
file into. 

• In the Sola-Scope 2000 Window select the file you want to upload the data 
into. 

• Click on the Paste Icon or press CTRL-V and the data will be uploaded. 
Note – If there is no valid data on the System Clipboard then the Paste Icon will not 
be enabled and the keyboard shortcuts will not work. 
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15 Using files that are already stored on your hard disk 

15.1 Loading the file into the Graph Window 
• If you have not already opened the Local Machine window, click on the Local 

Machine Window icon. 
• Locate the file you want to open in the Graph Window and either select it and 

click on the Open Icon, or double click on the file icon. 

15.2 Sending a file to Excel. 

15.2.1 Using the Excel - Single Graph Icon 
• If you have not already opened the Local Machine window, click on the Local 

Machine Window icon. 
• Select the file or files you wish to send to Excel. 
• Click the Excel -Single Graph Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button and your data will be transferred to Excel. 

15.2.2 Using the Excel - Separate Graph Icon 
• If you have not already opened the Local Machine window, click on the Local 

Machine Window icon. 
• Select the file or files you wish to send to Excel. 
• Click the Excel -Separate Graph Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button and your data will be transferred to Excel. 

15.2.3 Using the Excel Wizard Icon 
• If you have not already opened the Local Machine window, click on the Local 

Machine Window icon. 
• Select the file or files you wish to send to Excel. 
• Click the Excel Wizard Icon. 
• If Excel is not started you will be prompted if you wish to start Excel or not. 

Select the Yes Button, the Excel wizard will now start, follow the instructions 
given in the "The Excel Wizard" section later. 

15.3 Copying a file from the Local Machine Window to the system 
clipboard. 

• If you have not already opened the Local Machine window, click on the Local 
Machine Window icon. 

• Locate the file you want to copy to the system clipboard and click on the Copy 
Icon. 
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16 File Management 
This section applies to both the Sola-Scope 2000 Window and the Local Machine 
Window; any differences in operation will be detailed in the explanation of the 
operation. 

16.1 Deleting a file 
• Select the file you want to delete. 
• Either press the Delete key or select the File menu and click on the Delete menu 

item. 

16.2 Renaming a file 

 
• Select the file or bank you want to rename. 
• Open the File menu and click on the Rename menu item. 
• Change the name in the text box to the new name for the file or bank. 
• Click on the Ok button and the file/bank will be renamed. 

 

16.3 Copying Files 
To copy files you can either drag them from one window and drop them into another 
or in the Sola-Scope 2000 Window you can drag one file onto another. 
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17 Sending Data To Excel And The Excel Wizard 

17.1 Sending data without using the wizard 
To send data to Excel without using the wizard two icons are provided, these are the 
Excel – Single Graph Icon and the Excel – Separate Graph Icon. Instructions on the 
use of these icons is detailed in earlier chapters. 

17.2 Using the Excel Wizard 
The Excel Wizard is designed to give you the user more control over how data is 
transferred to Excel. Although there are several different methods for selecting the 
data that will be used in the Wizard, there are only two different paths through the 
Wizard. This is dependant on the number of files you are transferring to Excel. 

17.2.1 Sending data from single files to Excel with the Wizard 

17.2.1.1 Step 1 – Selecting the Workbook and Worksheet 

 
Step 1 in the Excel Wizard is used to select the Workbook and Worksheet you want 
your data to be transferred into. 

17.2.1.1.1 Changing the Workbook 
• Click the down arrow on the right hand side of the combo box, this will display a 

list of available Workbooks. 
• Either select one of the existing Workbooks from the list or select New to create a 

new Workbook. 

17.2.1.1.2 Changing the Worksheet 
• Click the down arrow on the right hand side of the combo box, this will display a 

list of available Worksheets. 
• Select one of the existing Worksheets from the list. 
 
(NOTE – Changing the Workbook will change the list of available Worksheets) 
 
Click the Next Button to progress to the next stage of the Wizard. 



 Sola-Term 2000 Manual 

- 23 - 

17.2.1.2 Step 2 – Selecting the Position where the data will be placed 
on the Worksheet 

 
Step 2 of the Excel Wizard is used to select the position on the Worksheet where the 
data is going to be placed and some options about which sections of the data are to be 
transferred. 

17.2.1.2.1 Selecting the data position 
• You can use the up-down controls on either side of the text boxes displaying the 

cell co-ordinates to alter the position of the data. 
• Alternatively you can click on one of the cells in the preview window and the cell 

co-ordinates in the text boxes will change. 

17.2.1.2.2 Altering the data transfer options 
• To not transfer the title (header) information to Excel select the Do not add titles 

to the columns check box. 
• To not transfer the Wavelength Column to Excel select the Do not copy the 

wavelength column check box. 
 
Click the Next Button to progress to the next stage of the Wizard. 

17.2.1.3 Step 3 – Graphing options 

 
Step 3 of the Excel Wizard is used to choose if the data is graphed or not. 

17.2.1.3.1 To not draw a graph of the data 
• To not draw a graph, make sure the Draw a Graph check box is not ticked. 

17.2.1.3.2 To draw a graph 
• Make sure the Draw a Graph check box is ticked. 
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• Select the name of an existing graph to add the data to that graph or type in a 
name of a graph that does not exist and a new graph will be created. 

 
Click the Finish Button and the data will be transferred to Excel. 

17.2.2 Sending data from multiple files to Excel with the Wizard 

17.2.2.1 Step 1 

 
Step 1 in the Excel Wizard is used to select the Workbook and Worksheet you want 
your data to be transferred into. 

17.2.2.1.1 Changing the Workbook 
• Click the down arrow on the right hand side of the combo box, this will display a 

list of available Workbooks. 
• Either select one of the existing Workbooks from the list or select New to create a 

new Workbook. 

17.2.2.1.2 Changing the Worksheet 
• Select one of the Data sets by clicking on one in the Data Source list located 

below the text box on the left-hand side of the window. 
• Click the down arrow on the right hand side of the Worksheets combo box, this 

will display a list of available Worksheets. 
• Select one of the existing Worksheets from the list. 
• Repeat this for each of your data sets. 
 
(NOTE – Changing the Workbook will change the list of available Worksheets) 
 
Click the Next Button to progress to the next stage of the Wizard. 
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17.2.2.2 Step 2 

 
Step 2 of the Excel Wizard is used to select the position on the Worksheet where the 
data is going to be placed and some options about which sections of the data are to be 
transferred. 

17.2.2.2.1 Selecting the data position 
• Select one of the Data sets by clicking on one in the Data Source list located on 

the right-hand side of the window. 
• You can use the up-down controls on either side of the text boxes displaying the 

cell co-ordinates to alter the position of the data. 
• Alternatively you can click on one of the cells in the preview window and the cell 

co-ordinates in the text boxes will change. 
• Repeat this for each of your data sets. 

17.2.2.2.2 Altering the data transfer options 
• To not transfer the title (header) information to Excel select the Do not add titles 

to the columns check box. 
• To not transfer the Wavelength Column to Excel select the Do not copy the 

wavelength column check box. 
 
Click the Next Button to progress to the next stage of the Wizard. 

17.2.2.3 Step 3 

 
Step 3 of the Excel Wizard is used to choose if the data is graphed or not. 

17.2.2.3.1 To not draw a graph of the data 
• To not draw a graph, make sure the Draw a Graph check box is not ticked. 
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17.2.2.3.2 To draw a graph 
• Make sure the Draw a Graph check box is ticked. 
• Select one of the Data sets by clicking on one in the Data Source list located 

below the text box on the left-hand side of the window. 
• Select the name of an existing graph to add the data to that graph or type in a 

name of a graph that does not exist and a new graph will be created. 
• Repeat this for each of your data sets. 
 
Click the Finish Button and the data will be transferred to Excel. 
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18 The Logging Wizard 
(NOTE - The Logging Wizard will not alter the Intensity of the scan that is set on the 
Sola-Scope 2000 so this must be set on the Sola-Scope 2000 to ensure that the scan 
does not saturate) 

18.1 Using the Wizard 

18.1.1 Step 1 

 
The first step in the Wizard allows you to select the resolution of the scan. This 
calculation is performed on the PC and will not effect the sample time of the scan. 
Once you have selected a resolution click the Next Button to continue. 

18.1.2 Step 2 

 
The second step in the Wizard allows the interval between scans and the number of 
scans to be set. The number of scans can range from 2 to 20 and the interval from 0 
seconds to 1000 minutes. 
It is possible to alter the scan interval and number of scans by either using the up-
down controls next to the text boxes or by typing the values directly into the text 
boxes. 
Once you have selected the scan interval and number of scans required click the Next 
Button to continue. 
 
(NOTE - if the Sola-Scope 2000 has a sample time that is longer that the interval set 
between scans then the Logging Wizard will start the next scan as quickly as it can 
after the previous scan has finished.) 

18.1.3 Step 3 
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The third step in the Logging Wizard allows you to set where the data from the scans 
is to be placed. It is possible to save the data to a file, send it to Excel or do both. 
Choosing to save the data to a file will require you to specify a filename; this can be 
accomplished by clicking on the Browse… button to open a standard save dialog or 
by typing the filename into the textbox at the bottom of the window. 
If you have chosen not to send the data to Excel then you can now click the Finish 
button and Sola-Term 2000 will start the logging process. 
If you have chosen to send the data to Excel then click the Next button to continue 
with the wizard. 

18.1.4 Step 4 

 
The final step in the Logging Wizard allows you to specify the Workbook, Worksheet 
and Start Cell the data should be placed when it is sent to Excel. The Workbook and 
Worksheets can be changed by either typing a name into their drop-down boxes or by 
selecting an entry from the respective drop-down list. 
The Start Cell can be changed by either typing the cell reference into the two text 
boxes or by using the up down controls. 
Once you have set the required Workbook, Worksheet and Start Cell click the Finish 
button and Sola-Term 2000 will start the logging process. 
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19 Miscellaneous Options 

19.1 Icon Views 
In the Sola-Scope 2000 Window, Local Machine Window, Networking Window you 
have the choice of four different styles of icons, Large Icons, Small Icons, List and 
Details. Selecting the relevant button from the toolbar or selecting the menu item 
from the View menu can switch between these views. 

19.2 Tile Horizontally 
Selecting Tile Horizontally from Window menu will arrange the windows you have 
open in the Main Window in a horizontal pattern. 

19.3 Tile Vertically 
Selecting Tile Vertically from Window menu will arrange the windows you have 
open in the Main Window in a vertical pattern. 
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20 Networking 

20.1 Configuring And Starting Your Network 
Before you can use your network of Sola-Checks and/or Sola-Sensor 2000s you must 
configure the network. 

 

20.1.1 Adding Sola-Checks/Sola-Sensor 2000s to the Network 
• Enter the Serial Number of the Sola-Check/Sola-Sensor 2000 into the Serial 

Number Text Box. (The serial number can be found on the back of your Sola-
Check/Sola-Sensor 2000.) 

• Enter a name in the Name Text Box to identify the Sola-Check/Sensor 2000. (This 
name is only used within Sola-Term 2000 to make identification of the Sola-
Check/Sola-Sensor 2000 easier and has no effect on the running of the network.) 

• Set the wavelength ranges for the areas by either using the up-down controls to the 
left of each of the Area Text Boxes, or by editing the Area Text Boxes by clicking 
on them and typing in values. 

• Click the Add Button and the Sola-Check/Sola-Sensor 2000 details will be 
entered into the list of Sola-Checks/Sola-Sensor 2000s that will be initialised 
when the network starts. 

20.1.2 Removing Sola-Checks/Sola-Sensor 2000s from the Network 

20.1.2.1 Removing a Single Sola-Check/Sola-Sensor 2000 
• Select the serial number of the Sola-Check/Sola-Sensor 2000 in the Serial 

Numbers List that you want to remove from the network. 
• Click the Remove Button. 
• A dialog box will appear asking for confirmation of the removal of the Sola-

Check/Sola-Sensor 2000 from the network, click the Yes Button and the Sola-
Check/Sola-Sensor 2000 will be removed from the Serial Number List. 

20.1.2.2 Removing all of the Sola-Checks/Sola-Sensor 2000s 
• Click the Remove All Button, a dialog box will appear asking you to confirm that 

you want to remove all of the Sola-Checks/Sola-Sensor 2000s 
• Click the Yes Button and all of the Sola-Checks/Sola-Sensor 2000s will be 

removed from the List. 
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20.1.3 Starting the Network 
Once you have added all of the Sola-Checks/Sola-Sensor 2000s that you require on 
the network click on the OK Button and after some initialising screens a dialog will 
appear informing you that your network has been started.  
 
If you enter a serial number of a Sola-Check/Sola-Sensor 2000 that is not on the 
network then a warning message will appear informing you of this. 
 
If the network fails to start then an error message will appear, you should check that 
all of the connecting leads are linked correctly and attempt to start the network again. 

20.2 Once the Network is Running 

20.2.1 Scanning an individual Sola-Check/Sola-Sensor 2000 
• Select a Sola-Check/Sola-Sensor 2000 from the Sola-Checks List. The selected 

check should now have the Selected Folder Icon representing it. 
• Click on either of the Scan Icons and the selected Sola-Check/Sola-Scope 2000 

will scan. 
Note – if an error occurs during the scanning or the scan was unable to start then the 
error message will appear in the Networking Errors Window. 

20.2.2 Setting the baseline on a Sola-Check/Sola-Sensor 2000 
• Select a Sola-Check/Sola-Sensor 2000 from the Sola-Checks List. The selected 

check should now have the Selected Folder Icon representing it. 
• Click on the Set Baseline Icon and the baseline will be set on the selected Sola-

Check/Sola-Sensor 2000. 

20.2.3 Network Monitoring 

20.2.3.1 Starting Network Monitoring 

 
• Click on the Network Monitoring Icon and the Network Interval Scanning Setup 

Window will appear. 
• Set the time interval between the scans by either editing the text boxes directly or 

by using the Up-Down Controls to the right of each text box. 
• Click the Start Button and the Sola-Term 2000 will start monitoring the Network. 

20.2.3.2 Stopping Network monitoring 
Click on the Network Monitoring Icon while monitoring is running and Sola-Term 
2000 will stop monitoring the Network. 

20.2.4 Logging an individual Sola-Check/Sola-Sensor 2000 on the 
Network. 

• Select a Sola-Check/Sola-Sensor 2000 from the Sola-Checks List. The selected 
check should now have the Selected Folder Icon representing it. 
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• Click on the Log Icon and the Logging Wizard should start, you can now follow 
the Logging Wizard as described in the Logging Wizard chapter earlier. 
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21 Using a Sola-Hazard with Sola-Term 2000 
(NOTE - Only Sola-Term 2000 versions 3.1.5 and above can be used to communicate 
with a Sola-Hazard.) 

21.1 Configuring Sola-Term 2000 for use with a Sola-Hazard. 
• Open the Options window by clicking on Options menu item under the Sola-

Scope menu in the main Sola-Term 2000 window. 

 
• Under the Select attached product frame select the Sola-Hazard option. This 

will grey out the Detect button and Ask if you want… controls above. 
• Using the up and down buttons next to the Com port number select the Com 

port that you have attached the Sola-Hazard to. 
• Click the Ok button and if Sola-Term 2000 was not already set to 

communicate with a Sola-Hazard then a message box will appear asking if you 
only want to show the relevant toolbars. 

• Click the Yes button in the dialog and Sola-Term 2000 will be configured to 
work with a Sola-Hazard; the main window will now look like the picture 
below. 

 

21.2 Receiving a file or banks from a Sola-Hazard 
There are two ways to prepare Sola-Term 2000 to receive data from a Sola-Hazard. 
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21.2.1 Using the Receive File icon 
• Click the Receive File icon on the tool bar and the downloading data window 

will appear. 
• You can now start the Sola-Hazard sending the file or bank(s). Refer to your 

Sola-Hazard manual if you are unsure how to do this. 

21.2.2 Using the keyboard shortcut 
• Hold down the CTRL key and press the D key and the downloading data 

window will appear. 
• You can now start the Sola-Hazard sending the file or bank(s). Refer to your 

Sola-Hazard manual if you are unsure how to do this. 

21.3 Sola-Hazard file format differences. 
There are two differences between the standard Sola-Term 2000 file format and the 
file format Sola-Term 2000 uses when a file is downloaded from a Sola-Hazard. 

1. The file has an extra header called Source that indicates where the file came 
from. This can be used to easily identify where a file originated. 

2. The intensity units of the scan data are stored in W/m2/nm instead of 
W/cm2/nm. This is due to the Sola-Hazard file format using W/m2/nm and 
removes the need to convert the data when comparing with data downloaded 
from older versions of Sola-Term. 

21.4 Sending data to Excel differences. 
As the Sola-Hazard version of the Sola-Term 2000 file format is in W/m2/nm the data 
transferred to Excel is also measured in W/m2/nm. This means that the label on the Y-
axis of the graph (if plotted by Sola-Term 2000) will be incorrect as it displays 
W/cm2/nm instead of W/m2/nm. 
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22 Error Messages 
The following is a list of the most common error messages you may encounter when 
using Sola-Term 2000. It details the cause, the meaning and the solution of the error 
message and the severity of the error. 
 
There are two different types severity for an error message, Minor and Major. Error 
messages that have a Minor severity are messages indicating that you have made a 
mistake, for example not plugging in the connecting lead from the Sola-Scope 2000 to 
the PC. Error messages that are classed as Major, indicate that something has gone 
wrong with Sola-Term 2000 and although the software can cope with this, it is 
advised that you restart Sola-Term 2000. 
If you do encounter an error message that is classed as having a Major severity then 
check the Solatell web site to see if there is an updated version of Sola-Term 2000 
that may solve your problem, if there is not please contact Solatell and report the error 
so we can fix it as quickly as possible. 
 
Error Message No Sola-Scope 2000 found. 
Severity Minor 
Operation Any that evolves communication between Sola-Term 2000 and the Sola-

Scope 2000 
Meaning This error indicates that there was a communications problem between Sola-

Term 2000 and the Sola-Scope 2000. 
Cause and Solution Many including – 

1. Cause – The connecting lead (the RS232 lead) that links the Sola-Scope 
2000 to the PC is not connected to either the PC, the Sola-Scope 2000 or 
both. 
Solution – Make sure that the connecting lead is plugged firmly into 
both the Sola-Scope 2000 and the PC. 
 

2. Cause – Sola-Term 2000 is configured to use a different 
communications port to the communication port that the connecting lead 
is plugged into. 
Solution – Alter the communications port that Sola-Term 2000 is using, 
see the “Configuring Sola-Term 2000 - The Options Window” section 
earlier in the manual for details of how to do this. 

 
3. Cause – The communications port is being used by another program. 

Solution – This is unlikely to happen but there are two solutions, the 
first is to stop the program that is using the communications port from 
using it. The second is to change the communications port that you are 
using to connect your Sola-Scope 2000 (ie. Move the connecting lead to 
another communications port) and alter the communication port settings 
in Sola-Term 2000. 
 

4. Cause – You have configured Sola-Term 2000 to use a communications 
port that does not exist. 
Solution – Alter the communications port that Sola-Term 2000 is using, 
see the “Configuring Sola-Term 2000 - The Options Window” section 
earlier in the manual for details of how to do this 

 
Error Message An unknown error has occurred, it is advised you restart Sola-Term 2000 
Severity Major 
Operation Any 
Meaning An error has occurred that was not expected. 
Cause and Solution N/A 
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